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1.0 General Information 

1.1 About this Manual 
This guide is for those with Guard access to the Fike Video Analytics system. It provides a brief overview of the 
operating features of the Video Management Software (VMS) and includes steps that should be taken by 
responding personnel should an alarm event occur. Some features of the software will be grayed out (non-
accessible) while in Guard mode. These are functions available only when in Administrator mode. 

The information presented in this guard’s guide is of a general nature, since each site and system is unique. 
The Fike Video Analytics system at your site has been designed by professionals to meet the specific fire and 
security requirements in your location. Please refer to site specific instructions, provided by your Fike Video 
Analytics representative, to determine the exact operation of your system. 

1.2 How Video Analytics Technology Works 
Video Analytics is enabling a rapidly growing number of video products such as smart cameras and intelligent 
digital video recorders (DVRs) with automated capabilities that just a few years ago would have required human 
monitoring. Broadly, video analytics is the extraction of meaningful and relevant information from digital video. 
Video Analytics builds upon research in computer vision, pattern analysis and machine intelligence, and is also 
called video content analysis (VCA) or intelligent video.  

Similar to human vision, which has a perceptual and cognitive aspect, video analytics uses computer vision 
algorithms which enable it to perceive or see, and machine intelligence to interpret, learn and draw inferences. 
The goal of video analytics is scene understanding, which differs from motion detection. In addition to detecting 
motion, analytics qualifies the motion as an object, understands the context around the object, and is able to 
track the object through the scene. 

Fike Video Analytics has two options for video fire detection; a UL listed, Factory Mutual approved, NFPA 
compliant camera with analytics internal to the camera and computer software that can monitor and analyze 
video from off the shelf cameras (ONVIF). Fike analytics includes 4 standard algorithms to detect smoke (also 
used for oil mist detection), flame, reflected flame (called Offsite) and motion.  

Smoke: In the most basic sense, video analytics’ algorithms for smoke detection monitor the image for 
movement of light patterns relative to a stable background. If the movement is consistent with “known” smoke 
movement patterns, and preset alarm zone, sensitivity and time delay thresholds are met, then an alarm is 
generated.   

Flame detection: The analytics are monitoring the same stable background and looking for groups of pixels 
indicating slow changing brightness accompanied by known dynamic flicker signatures.  

Offsite (reflected flame): The algorithm is similar to flame in that it detects slow changing brightness and flicker, 
however spread over a larger area. 

Motion: Can be detected and tracked, if desired, to monitor for motion of people, vehicles, or depending on the 
sensitivity settings, rodents have been tracked.  

The technology has been successfully applied in varied hazards from light hazard airport catering facilities and 
museums to power plants, aircraft hangars, ship engine rooms and outdoor chemical processing.  

  



Video Management Software  Guard Mode User’s Guide 

Doc. P/N 06‐819 
Rev. 4 / June 2019 

PAGE / 3 

 

1.3 Terminology 
Throughout this document there are terms which are used interchangeably. 

Term Legend 

Fike Video Analytics Proprietary technology for fire and smoke detection utilizing digital 
imaging devices. That may include digital video cameras with 
embedded firmware or standalone processing units capable of 
processing digital or analog video signals captured by third party 
devices.  It also includes  systems or devices that are supporting a 
video fire and smoke detection such as remote operator workstations, 
video recording/storage systems, etc. 

Fike Video Analytics 
IP Camera 

Refers to Digital Network Camera with embedded fire and smoke 
detection capabilities 

FSM-IP (NVR) Fire, Smoke, Motion – Internet Protocol, refers to Event Management 
and Video Storage server known also as Network Video Recorder 
(NVR) 

Server ID A combination of network name (or IP address) of the server with the 
TCP connection port used to connect to FSM-IP NVR. 

Operator (guard) A person that is dedicated to monitor the facilities. Operator can be 
physically located on the premises, or in case of remote monitoring, 
can be dialing into the system from the remote location. 

Administrator (admin) A person that is delegated the rights to configure the system 

Main Window The main Video Management Software window 
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1.4 Symbols 
Throughout the application you will see the following symbols used to depict status  

 Alarm  

 

This symbol is used throughout the application to indicate that a 
camera is in a general alarm state: this could be any combination of 
flame, smoke, offsite, motion or guard alarms. 

 Disconnected 

 

This symbol is used throughout the application to indicate that there is 
a network connectivity problem between a server and camera. This 
can indicate that the camera is not powered or there is no valid network 
path between the server and the camera. 

 Fault 

 

This symbol is used throughout the application to indicate that a 
camera is in a fault state: this could be any combination of content or 
focus faults. 

 Flame This symbol is used throughout the application to indicate that a 
camera is experiencing a flame alarm. 

 Motion This symbol is used throughout the application to indicate that a 
camera is experiencing a motion alarm. 

 Offline 

 

This symbol is used throughout the application to indicate that a server 
is offline. 

 Smoke 

 

This symbol is used throughout the application to indicate that a 
camera is experiencing a smoke alarm. 

 User 

 

This symbol is used throughout the application to indicate that a 
camera is experiencing a User alarm. User alarms are initiated 
manually by a user through the Video Management Software. 

 Maintenance This symbol is used throughout the application to indicate that a 
camera has been placed into maintenance mode (ONVIF cameras 
only). 

 Calibration This symbol is used throughout the application to indicate that a 
camera has been placed into calibration mode (ONVIF cameras only). 
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2.0 Fike Video Analytics System Overview 
The Fike Video Analytics system is comprised of at least one IP camera, a video management system, and the 
video management monitoring station. You can connect any number of IP cameras and network recorders via 
standard LAN / Ethernet network to expand the system to meet system requirements. There is no 
predetermined limit on the number of cameras and NVRs that can be deployed on one network; however, the 
actual performance can be greatly affected by bandwidth limitations on a particular network. The number of 
NVRs that the Video Management Software (VMS) can handle is unlimited and built-in smart bandwidth 
management limits the network video transfers to only those channels that are currently observed by the 
operator. Therefore, there is no deterioration of the frame rate observed by the operator. 

There are many acceptable ways to configure the Fike Video Analytics system architecture. Three of the most 
basic and most implemented methods are described as follows. 

2.1 FSM-IP NVR System Architecture 
The FSM-IP Network Video Recorder (NVR) event management server is designed to network with up to 32 
Fike Video Analytics IP cameras and an unlimited number of VMS monitoring stations [Figure 1]. The software 
contained within each Fike Video Analytics IP camera uses analytics to continually process video in real-time, 
frame-by-frame, to detect anomalies characteristic of smoke, fire and motion and when an event occurs, the 
camera(s) will transmit the video over the network to the FSM-IP NVR and the VMS workstation. The on-duty 
guard receives an early warning notification along with live video from the location. The FSM-IP NVR provides 
the digital storage for constant recording of the video images from the Fike Video Analytics IP cameras. The 
NVR also acts as an information conduit between the VMS monitoring station(s) and the cameras themselves. 
The NVR allows on-request playback of prerecorded videos at multiple VMS workstations simultaneously. This 
architecture is most commonly used when 24/7 monitoring is present and personnel can respond quickly to an 
event. 

 

Figure 1: FSM-IP NVR Networked System Architecture (not UL Listed) 
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2.1.1 FSM-IP NVR System Connected to a Fire Alarm System 

A variation of the FSM-IP NVR system architecture expands upon the system by using the integral dry relay 
contacts provided on each Fike Video Analytics IP camera to transmit event signals to a Fire Alarm Control 
Panel (FACP) [Figure 2]. This system architecture is most commonly used in installations that may not have 
24/7 guards and want to ensure a response to an event. In this configuration, the Fike Video Analytics IP 
cameras must be powered by one of the following: 1) FACP, 2) an approved security and fire camera power 
supply with battery backup or 3) as a supplemental means, a PoE switch with battery backup.  

 

Figure 2: FSM-IP NVR Networked System Connected to an FACP (UL Listed) 
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2.2 Event Management Server System Architecture 
The Fike Video Analytics event management server is designed to network with up to 16 ONVIF IP cameras 
and an unlimited number of VMS monitoring stations [Figure 3]. Unlike the FSM-IP server system, the analytics 
for processing the camera video is not contained within the cameras, but in the server itself. The server comes 
loaded with the appropriate software that allows it to process video in real-time, frame-by-frame, to detect 
anomalies characteristic of smoke, fire and motion and when an event occurs, the server will transmit the video 
over the network to the VMS workstation. The on-duty guard receives an early warning notification along with 
live video from the location. The server provides the digital storage for constant recording of the video images 
from the ONVIF cameras. The server also acts as an information conduit between the VMS workstation(s) and 
the cameras themselves. The server allows on-request playback of prerecorded videos at multiple VMS 
workstations simultaneously. This architecture is most commonly used when existing ONVIF compliant security 
cameras are installed. 

 

Figure 3: Event Management Server Networked System Architecture (not UL Listed) 

  



Guard Mode User’s Guide  Video Management Software 

PAGE / 8   Doc. P/N 06‐819 
Rev. 4  / June 2019

 

3.0 Guard Interface Overview 
The Video Management Software (VMS) is a customizable surveillance and alarm monitoring application that 
is able to work with one or more FSM-IP server installations. What makes VMS rather unique is its ability to 
configure access to video channels in accordance to the organizational, geographical and topological structure 
of your organization. The advantage of this is that you can navigate the system across the facilities using simple 
terms such as sites, buildings, levels, suites, etc. as opposed to servers and channel numbers. 

To start VMS, double-click on the program icon located on the computer desktop. The 
software’s Main Window [Figure 4] will be displayed. Verify that the software is in Guard Mode 
by checking the status of each server in the User column. If any server indicates Admin, contact 
your system administrator. 

NOTE: VMS can only be closed by the System Administrator. 
 
NOTE: Some features of the Video Management Software are grayed out (non-accessible) while in guard 
mode. These functions are available only when the software is in Administrator mode. Modifications to these 
items can affect system performance and should only be accessed or modified by persons with administrative 
access. 

3.1 Main Window 
The two major parts of the software’s Main Window [Figure 4] are the main menu and the five tab selectable 
views, each defining a specific function of the system. 

 

Figure 4: Video Management Software Main Window Layout 
  

Main Menu 

Tabs 
Server Section 

Channel Section 

Status Bar 

User Mode 
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3.2 Main Menu 
The Main Menu [Figure 5] allows you to navigate the general configuration options for the Fike Video Analytics 
system. Figure 5 lists the options available on the Main Menu. 

 

Figure 5: Main Menu 

3.2.1 File Menu 

 

Figure 6: File Menu 

 New 

Not accessible in Guard mode 

 Open… 

Not accessible in Guard mode 

 Close 

Not accessible in Guard mode 

 Recent files 

Not accessible in Guard mode 

 Save 

Saves the current configuration.  

 Save As… 

Save the current configuration prompting for a file name 

 Settings… 

Not accessible in Guard mode 

 Exit 

Not accessible in Guard mode 
  



Guard Mode User’s Guide  Video Management Software 

PAGE / 10   Doc. P/N 06‐819 
Rev. 4  / June 2019

 

3.2.2 Edit Menu 

The Edit menu options allow you to manipulate the elements of the “Organizational Tree” found in the 
Browser tab. The Edit menu can also be accessed by right clicking on the browser tree area under the 
Browser tab. 

 
Figure 7: Edit Menu 

 New 

Not accessible in Guard mode 

 Delete 

Not accessible in Guard mode 

 Expand 

Expands the selected browser tree element to display all of the elements children 

 Collapse 

Collapses the selected browser tree element to hide all of the elements children 

 Properties 

Not accessible in Guard mode 

3.2.3 Tools Menu 

 
Figure 8: Tools Menu 

 E-Mail agent.. 

Not accessible in Guard mode 

 Send e-mails on alarm 

Not accessible in Guard mode 

 Relay Switchboard… 

Not accessible in Guard mode 

 Upgrade Firmware 

Not accessible in Guard mode  
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3.2.4 Audit Menu 

 

Figure 9: Audit Menu 

 Generate.. 

Allows you to generate a system audit report [Figure 10]. The audit report is used to provide a hard paper 
copy of the Fike Video Analytics system configuration. This is useful for documenting and checking the 
system configuration during system maintenance to ensure the system has not been compromised. 

 
Figure 10: System Audit Report 

 

Figure 11: Audit Menu 
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 Print Prints the Audit report to a connected printer. 

 Print to PDF Prints the Audit report to an Adobe PDF file. 

 Skip to beginning Jumps to the first page of the Audit. 

 Step Back Steps one page back. 

 Step Forward Steps one page forward. 

 Step to End Jumps to the last page of the Audit. 

The report can then be saved as an .audit file by selecting File>Save Data… or closed by selecting 
File>Exit from the File menu [Figure 11]. 

 Verify.. 

Allows you to open a saved audit report and compare it to the VMS current settings. This is useful for 
documenting and checking system configuration settings during maintenance to ensure the system has not 
been compromised. If a setting has been changed, the verify feature highlights the change so corrective 
action can be taken.  

To verify an audit, select Verify from the Audit Menu. You will be prompted to browse for an old audit file to 
compare the current settings too. Once selected, VMS will compare all the camera settings including field 
of view and will display the results for review in the audit list [Figure 12]. 

 

Figure 12: Audit Review Display 

NOTE: Verify will only work with a saved .audit file. 
  

Audit Tabs 

Audit List 

Audit Details 
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The audit list displays the following information pertaining to the audit. 

# Channel number of the camera being audited. 

Serial # Serial number of the camera being audited. 

Address IP address of the camera being audited. 

Name Name of the camera being audited. 

Date/Time Time audit was performed. 

Audit Audit results (Pass/Fail). 

 
If a problem is detected during the audit review, it will be highlighted on the camera icon and a fail grade 
will exist for the camera in the audit column [Figure 13]. A fail can occur for a number of reasons and does 
not necessarily mean the system is not functioning. For example, if enough of the content of the image has 
changed, the image match could get a failing grade even though the camera is properly aligned and 
correctly covers the hazard area. The fail indicator means further examination is required to ensure the 
system is working properly.  

 

Figure 13: Audit Review Fail Display 

Within the Audit Review you can drill down into each camera's settings and audit results using the three 
audit review tabs located on the middle left of the Audit Review screen. 

  

Fail Indicator 

Failure Category 

Failure Description 

Audit Tree 

Audit Review Tabs 
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Inspect tab - Provides detailed information regarding the Audit Review results. Upon selecting a channel 
number from the audit list, details concerning the cameras inspection results will be displayed in the three 
windows as shown in Figure 13. 

Report tab [Figure 14] - Generates a printable version of the audit report for the selected channel. The 
report shows a side-by-side comparison between the saved audit report and the current system 
configuration. Any changes detected during the audit will be visually indicated in the report. 

The print button  enables you to print a copy of the report.  

 

Figure 14: Audit Report Printout 
 
  

Report Tab 
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Images tab [Figure 15] - Allows you to compare the previous recorded image to the current camera 
image to ensure that the camera's field of view has not changed. 

 
Figure 15: Comparing Camera Images in Audit Review 

 Alternates the image display between the saved audit image and the current image. 

 Generates a black and white sketch of the camera images for comparison. 

  Displays any zone boundaries assigned to the camera. 

  

Images Tab 



Guard Mode User’s Guide  Video Management Software 

PAGE / 16   Doc. P/N 06‐819 
Rev. 4  / June 2019

 

 Review.. 

Allows the guard to open a saved audit report for review. 

3.2.5 Help Menu 

 

Figure 16: Help Menu 

 Manuals 

Manuals are available at www.fike.com 

 About… 

Displays a splash screen indicating the firmware version of the software. 

3.3 Main Window Tabs 
The working area of the main window consists of five tab-selectable views [Figure 17]. Each tab view performs 
a specific function of the system.  

 

Figure 17: Main Window Tabs 

The tabs include the following: 

Servers Provides access to system components that include FSM-IP servers and their respective 
video channels. 

Browser Provides access to the video organizational structure and related video feeds. 

Alarms Provides direct access to all alarms registered by the system. A video of the channel 
responsible for the alarm will automatically appear in this view. The VMS application may be 
configured to maximize the window as new alarms come along and switch to the Alarms view. 

Archive Allows guards to search through past alarms as well as view and/or download previously 
recorded videos. 

Timeline Displays the recorded alarms in a graphic chart and lets you replay prerecorded videos 
including those channels and time periods that were not under alarm conditions. 

  

Main Window Tabs 
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3.3.1 Servers Tab 

The Servers Tab [Figure 18] allows you to manage FSM-IP servers and their respective channels (cameras). 
The screen is broken into two main sections: servers on the top and channels on the bottom. The channels 
displayed in the channels section are always the channels connected to the currently selected server. 

 

Figure 18: Servers Tab 

3.3.1.1 Servers Section 

The Servers section [Figure 19] includes a server toolbar and a server list. The server toolbar allows you to 
perform functions associated with adding or removing a server from the Video Management Software 
application. Once a server is added to the system configuration, it will be displayed in the server list. 

 

Figure 19: Servers Section 

  

Channels Section 

Servers Section 

Servers Toolbar 

Servers List 
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The Servers toolbar provides the following functions: 

 Add Server 

Allows you to add a new server to the current Video Management Software configuration or to switch a 
server between Guard or Administrator mode. When clicked, the Server Editor dialogue box [Figure 20] will 
be displayed enabling you to enter the parameters for the new server. If server security is enabled, a 
password must be entered in order to save changes made in the Server Editor. While this feature is 
accessible in guard mode, modifications can affect system performance and should only be 
accessed or modified by persons with administrative access. 

 

Figure 20: Server Editor 

Once Save is selected, the new server will be added to the server list. The server list displays the following 
details for each server that is added to the VMS workstation [Figure 21]. 

 

Figure 21: Server List Information 

Address Displays the IP address of the server 

Port Displays the network port of the server (do not change) 

State Displays the status of the server (online or offline) 

Server Time Displays the current time and date of the server 

Version Displays the current firmware version of the server 

User Displays the current access level being used by the server (Administrator or Guard) 

Security Displays if security (password protected) is enabled on the server 

 Displays the status of the server (Server online or Disconnected from server)  
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 Remove Server 

Not accessible in Guard mode 

 Connect 

Not accessible in Guard mode 

 Disconnect 

Not accessible in Guard mode 

 Properties 

Not accessible in Guard mode 

 Upgrade 

Not accessible in Guard mode 

Selecting and then right-clicking on a server in the list will open a Server menu [Figure 22] for that server. The 
server menu allows you to perform most of the same functions found on the Servers toolbar. 

 

Figure 22: Server List Options 
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3.3.1.2 Channels Section 

The Channels section [Figure 23] includes a channel toolbar and a channel list. The channel toolbar allows you 
to perform functions associated with setting up a channel (camera) for operation with the VMS system. Once a 
camera is added to the application configuration, it will be displayed in the channel list. 

 

 

Figure 23: Channel Section 

 Jump to Browser 

Switches to the Browser tab [Figure 24] and displays the first camera in the Organizational Tree with this 
channel bound to it.  

 

Figure 24: Browser Tab 
  

Channels Toolbar Channels List 
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 Jump to Layout 

Switches to the Browser/Layout tab [Figure 25] and displays the first item in the Organizational Tree with 
this channel as a child. The background images used in the layout tab are custom defined to suit each 
project. Any level of the Organizational Tree, except a camera, may be associated with a graphical layout 
such as floor plans, satellite photos, logos, etc. that can be viewed from the Layout tab. 

If the selected Organization Tree element has camera objects as children, the image will be overlaid with 
iconic camera designators showing the general location of the cameras with respect to the background 
image. Otherwise, each child object will be highlighted by rectangles that define the area where the event 
is occurring. 

 

Figure 25: Browser/Layout Tab 

 Properties 

Not accessible in Guard mode 

 Reboot 

Not accessible in Guard mode 

 Add channel.. 

Not accessible in Guard mode 

 Remove Channel 

Not accessible in Guard mode 
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The Channel list [Figure 26] displays the following details for each channel that has been added to the event 
management server. 

 

Figure 26: Channel List 

Channel Displays the unique channel ID assigned to the camera by the server 

State Displays the status of the camera (online or offline) 

Status Displays the alarm status of the camera 

Name Displays the unique name assigned to the camera 

Address Displays the IP address of the camera 

Version Displays the firmware version running on the camera 

Serial Displays the serial number of the camera 

Selecting and then right-clicking on a channel in the list will open a Channel menu [Figure 27] for that channel. 
The Channel menu allows you to perform most of the same functions found on the Channels toolbar. 

 
Figure 27: Channel List Menu Options 
  

Channel Menu 
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3.3.2 Browser Tab 

The Browser tab [Figure 28] allows you to navigate the Organizational Tree and has three sub tabs that allow 
you to view information associated with an organization element and provides quick access to cameras and 
floor plans.  

 

Figure 28: Browser Tab 

3.3.2.1 General Sub Tab 

The General sub tab [Figure 29] allows you to view certain features of the currently selected organizational 
element. Each element in the Organizational Tree has different information associated with it that can be 
customized. If the organizational element is a camera, two additional configuration tabs become available under 
the General sub-tab: Channel and Speech. 

 

Figure 29: General Sub Tab 
 
  

Organizational Tree 

Browser Tab 

Organizational Element 
Details Change Depending 
Upon Element Selected. 

General Sub Tab 

Organizational Tree Elements 

Browser Sub Tabs 
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3.3.2.1.1 Channel Tab 

The Channel tab [Figure 30] allows you to initiate several functions associated with the channel selected in the 
organizational tree.  

 

Figure 30: Channel Tab 

 Maintenance Mode (ONVIF cameras only) 

The Maintenance button [Figure 30] allows you to put the selected channel in maintenance mode for a 
specified period of time. When selected, the Maintenance Setup form [Figure 31] will be displayed allowing 
you to setup and initiate the maintenance mode on the selected camera. 

NOTE: This feature is used to disable a camera when maintenance is being performed in the area the camera 
serves in order to prevent false smoke alarms. While in maintenance mode, the camera will respond to 
all other system events. 

  

Channel Tab 
Maintenance Button 
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Figure 31: Maintenance Setup Form 

Maintenance Mode Enables maintenance mode on the selected channel (ONVIF cameras only). 

Choose Server Allows you to choose the server. 

Choose Camera Allows you to choose the camera. 

Maintenance 
Timeout 

Allows you to set the length of the maintenance timeout in hours and minutes. 

Submit Begins a maintenance timeout event on the selected channel. The icon for the 
chosen camera in the organizational tree will change to a flashing 

maintenance mode icon  to provide positive indication that the camera is in 
maintenance mode. After the timer expires, the camera will automatically 
return to normal operation. 

Cancel Exits the Maintenance Setup screen. 
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Right clicking on the camera image will bring up a Channel menu [Figure 32] that provides additional camera 
functions.  

 

Figure 32: Channel Menu Options 

 Camera 

Allows you to initiate the following functions associated with the camera. 

Start Recording Begins a User event on the selected channel (Fike Video Analytics IP camera 
only) 

Stop Recording Stops a User event on the selected channel (Fike Video Analytics IP cameras 
only). 

Reboot Not accessible in Guard mode 

 Show Zones 

Not accessible in Guard mode 

 Copy Image 

Allows you to copy and paste the current channel image into another program. 
  

Channel Menu 
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3.3.2.1.2 Speech Tab 

The Speech tab [Figure 33] allows you to make changes to the voice settings associated with the selected 
channel. By default all alarms are announced through the speech system. Each channel’s settings are stored 
in the local configuration file. 

 

Figure 33: Speech Tab 

 Volume (slider)  

Sets the speech volume level for the channel 

 Speed 

Sets the speech voice speed for the channel 

 Voice 

Sets the speech voice that will be used by the channel (Uses Microsoft Windows text to speech files.) 

 Alarm Filter 

Sets which event types will have voice announcements 

 Test 

Tests the voice configuration using the current settings 

 Mute  

Checking the “Mute” checkbox will mute all voice announcements for the channel 
  

Speech Tab 
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3.3.2.2 Cameras Sub Tab 

The Cameras sub tab [Figure 34] displays the cameras under the current Organizational Tree selection. 
Selecting an individual camera will display the image for that channel only; whereas, selecting an item higher 
up in the Organizational Tree may display several cameras associated with the selection as shown below. 

Where the selection requires multiple camera images to be shown, the software allows you to adjust how many 
camera images will be displayed on the screen by adjusting the number of columns to display. The Best Fit 
button will adjust the current camera image to fill the viewing area. At any time in the application, you can double 
click on a camera image to view it full screen. 

 

Figure 34: Cameras Views for selected Organizational Tree Element 
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3.3.2.3 Layout Tab 

Any element of the Organization Tree, except a camera, may have a graphical layout such as floor plans, 
satellite photos, logos, etc. associated with it that can be observed from the Layout tab. The background images 
used in the Layout tab are custom defined to suit each project.  

 
Figure 35: Layout View with Camera Designators 

 Up 
Moves up one level in the organizational tree, unless the current 
selection is a root level organization 

 Reset Resets the layout to the default zoom level 

 Best Fit Attempts to perform a best fit zoom of the layout 

 In Zooms in on the layout 

 Out Zooms out on the layout 

 Print Prints the current layout 

 Set Background Not accessible in Guard Mode. System Administrator Use Only. 

 
Clear 
Background 

Not accessible in Guard Mode. System Administrator Use Only. 

  Edit Not accessible in Guard Mode. System Administrator Use Only. 

  

Custom Background Image 

Camera Designator – 
double click to open 
and close camera video 
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3.3.3 Alarms Tab 

The Alarms tab [Figure 36] displays active and inactive events. Real-time video images of all active events will 
populate the video area of the Alarms tab. When detecting events, the Video Management Software can be set 
to automatically maximize the Alarms tab window if minimized or bring the Alarms tab forward if another screen 
is open. This allows you to immediately start assessing the situation. By default, the alarm view functionality is 
enabled during system setup. 

 

Figure 36: Alarms Tab 

 Maintenance Mode (ONVIF cameras only) 

The Maintenance button [Figure 36] allows you to put the selected channel in maintenance mode for a 
specified period of time. When selected, the Maintenance Setup form [Figure 31] will be displayed allowing 
you to setup and initiate the maintenance mode on the selected camera. 

NOTE: This feature is used to disable a camera when maintenance is being performed in the area the camera 
serves in order to prevent false smoke alarms. While in maintenance mode, the camera will respond to 
all other system events. 

  

Camera Image of Alarm Event 

Alarm List Toolbar 

Alarm List (active and inactive) 
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The alarm list toolbar has a row of action buttons that lets you handle the alarm events. The tool bar includes 
the following actions. 

 Reset Not accessible in Guard mode. 

 Reset all Resets all active events in the list. Same effect as above, but applies to all active 
events.  

 Delete Deletes the selected event from the alarm list if it has been completed. 

 Delete all Deletes all completed events from the active alarm list. 

 Alarm Video 
View 

Switches view to Alarms tab whenever an event is active. 

 Keep time Sets the amount of time to keep closed alarm events in Alarm view. Note that all 
events in the database will be visible in Archive and Timeline view. 

Each time the Video Management Software registers an event, a line item will be added to the alarm list [Figure 
37]. The events are ordered by age with the oldest events at the top and the newest at the bottom. While the 
conditions continue that caused the alarm, the alarm is in an active state indicated by the “In progress” message 
in the Stop time column. Once the alarm condition is no longer present, the alarm becomes inactive. 

 

Figure 37: Alarm List Details 

Alarm Type Event type associated with the alarm 

Age Time since the alarm started 

Start Time Local time when the event started 

Stop Time Local time when the event ended 

Duration How long the event remained active 

Host IP address of the server where the alarm originated 

Channel Channel number that the event originated from 

Comment Description of the event 

 

  

Event in Progress 
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After the alarm becomes inactive, the video recordings of the event can be deleted or played back. To play 
back the event, right-click the event in the alarm list and select Play Event [Figure 38]. To remove inactive 
alarms from the list, you can use the Delete or Delete All buttons in the alarm list toolbar or you can right-click 
the event in the alarm list and select Delete. Removing inactive alarms does not remove them from the NVR 
storage. Older alarms still can be observed in the Archive and Timeline tabs. 

 

Figure 38: Event Playback 

  

Play Event 

Delete Event 
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3.3.3.1 Reading the Camera Image 

Two informational lines are superimposed onto each camera image [Figure 39].  

 

Figure 39: Reading Camera View Image 

  

Lower Information Line 

Upper Information Line 
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The information line located at the top of the image provides the following information:  

000- 
Indicates the state of the Fike Video Analytics IP cameras integral relays (1-3). 
0 = relay in normal state and 1 = relay is in alarm state 

R1:-R2:-R3:- 

Event codes for each camera relay (1-3). The event codes indicate what 
condition is required for the relay to close. Event codes are: 
1-Flame 
2-Smoke 
3-Offsite 
4-Motion 
5-User 
6-External (not used) 
7-Dark 
8-Bright 
9-Featureless (content) 
0-Focus 
A-Network 

Example: R3:24 as shown in Figure 39 indicates that relay 3 will engage on 
smoke and motion. 

A-159-00 
Relay countdown display 
Example: A-159-00 as shown in Figure 41 means Automatic countdown, 159 
second delay and the state of the countdown. 

10.0.0.174 IP address of the camera 

00:1B:5A:00:00:97 MAC address of the camera 

1.868 Firmware version of the camera 

801 Image quality of the camera 

1 Number of connections 

38 Camera illumination (lux) 

The information line located at the bottom of the image provides the following information:  

Warehouse_Camera_1 Name of the camera. 

14-08-26 Current date (Y/MM/DD) 

09:06:27 Current time 

15:18 Camera Frame Rate 

(58:00%) CPU Usage 

[18] Cycle Process Time (milliseconds) 

FSO 
Active Algorithm Indicator. If any of these detection algorithms has been turned 
off, you will see an “X” over the corresponding letter. 
F = flame; S = smoke; O = offsite 

38 Camera illumination (lux) 
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3.3.3.2 Optional Annunciator 

An optional annunciator [Figure 40] can be added to the Fike Video 
Analytics system. The annunciator plugs into an available USB port on the 
VMS workstation to provide visual indication of system alarm events as 
follows. 

Flashing Green – Event has been acknowledged but is still recording the 
event. Once the event is no longer in progress, the light will turn off. 

Flashing Red – Alarm event is active and Alarm dialogue box is displayed 
on the Alarms tab screen.  

Once the annunciator is plugged into the PC’s USB port, the VMS 
application will provide positive indication in the status bar at the bottom of 
the Main Window that the software recognizes that the annunciator is 
attached [Figure 41]. 

 

 
Figure 41: Annunciator Attached Indicator 

With Annunciator Mode on, the VMS application will display an Alarms dialogue box [Figure 42] on the Alarms 
Tab in response to an alarm event. The dialogue box will indicate the event type and the assigned name 
given to the channel (camera) in the Browser tree. 

 

Figure 42: Alarm Notification and Response Dialogue Box 

Minimize SpyderGuard Allows you to minimize the VMS application window. 

Silence Alarms for _ mins 
Allows you to silence the active alarm events shown in the Alarm dialogue 
box for a set number of minutes (1 to 100 min.). 

Acknowledge 
Allows you to confirm that the event has been acknowledged. Annunciator 
will flash green. 

  

Annunciator Attached 

Figure 40: Annunciator 
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3.3.4 Archive Tab 

The Archive tab [Figure 43] provides search functionality for finding past events and their associated video 
recordings. The records can be played, downloaded or saved. Here the list of events can be generated 
according to set search criteria. Once the filter settings for the search criteria are set up, selecting the Search 
button will produce a list of events that satisfy previously set criteria. Now you may choose a particular alarm of 
interest and play back the video recording made at the time when it occurred. 

 

Figure 43: Archive View with search results 

The following quick-search parameters are provided to filter the alarms in the list. 

 Server 

The server to search by; defaults to all servers. 

 Channel 

The channel to search by; defaults to all channels. 

 Alarm Type 

The alarm type to search by; defaults to all alarm types. 

  

Filter Settings 

Generated list of 
alarms satisfying the 

search criteria 

Filter List Toolbar 
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 Start Time 

The start time to filter results by; defaults to include all alarms started within the last 24 hours. This search 
option can be enabled or disabled (enabled by default). 

 Stop Time 

The stop time to filter results by. This search option can be enabled or disabled (disabled by default). 

 Duration 

The duration to filter results by. Duration is the length of time the alarm was active. This search option can 
be enabled or disabled (disabled by default).  

 Age 

The age to filter results by. The age is how old the alarm is. This search option can be enabled or 
disabled (disabled by default). 

Events meeting the search criteria will be displayed in the search results list [Figure 44]. 

 

Figure 44: Archive Search Results List 

Server 
IP address or hostname and port number of the FSM-IP server where the alarm data is 
stored. 

Channel Channel number the alarm occurred on. 

Alarm Type Type of alarm that occurred. 

Duration How long the alarm lasted. 

Age Time passed since beginning of the alarm. 

Start Time Date and time when the alarm started. 

Stop Time Date and time when the alarm stopped. 

Video Alarm has an associated video 
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Selecting and then right clicking on an individual event in the list will display a menu that allows you to perform 
additional functions associated with the selected event [Figure 45]. 

 

Figure 45: Single Event Options 

 Print… 

Prints the current search results list 

 Copy 

Copies the search list results (txt format) 

 Export.. 

Exports the current search results list to a CSV file. 

 Save Movie… 

Saves the selected event movie as an AXONX media file (*.axm) or Windows Media file (*.wmv) 

 Play Movie.. 

Plays the selected event movie using VLC Media Player 

 Channel Properties 

Not accessible in Guard mode 

3.3.4.1 Archive Toolbar 

 
Figure 46: Archive Toolbar 

 Print 

Prints the list of generated events 

 Clear 

Clears the event list 

 Search 

Initiates a search criteria using selected search criteria 

 Download 

Allows you to download the video file associated with the selected event onto your local machine. The 
system will prompt you for a location and name of the video file (AXM or WMV) and will download and save 
the file. Once saved, the software will give you the option to play the video now.  

 View 

Allows you to play back any selected event that has a video using VLC Media Player [See 3.3.4.2].  To use 
the media player, simply click the View button 

 Export 

Allows you to export the archive search results list to an external comma separated file onto your local 
machine.  
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3.3.4.2 Video Player 

The video player [Figure 47] streams the archived videos from the NVR and displays them on the screen. 

 

Figure 47: Video Player Window Layout 

The video player provides several features that allow you to control how the video is played including a position 
slider that allows you to select any point in the video to begin playback along with a toolbar that provides the 
following functions. 

  

Position slider Player Toolbar 
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 Skip Backward Skips one frame backward 

 Step Backward Steps one frame backward 

 Play Plays the video 

 Pause Pauses the video 

 Stop Stops the video; resets playback position to zero 

 Step Forward Steps one frame forward 

 Skip Forward Skips one frame forward 

 Rate: Rate settings allow you to increase or decrease the general 
playback speed. 

 Compress Compression allows you to filter out the long sections of time 
from the video where only idle frames were recorded. 

 Close  Closes the video player.  

3.3.5 Timeline Tab 

The Timeline tab allows you to review the events and video recordings stored in the archive in a Gantt chart 
showing the alarm events in each channel of the selected NVR server. In addition to viewing video recordings 
of alarms, with the timeline you can see video recordings from any channel and at any point in time within the 
capacity of the NVR [Figure 48].  

 

 

Figure 48: Timeline Window 

Before Timeline can display the events, you need to select the server. Choose the server from the list of all 
available online servers in the Server selector. The VMS application will respond by filling up the channel bars 
indicating events that took place on each particular channel within the selected time window.  Each horizontal 
bar represents a particular channel. The time window default value is 30 minutes but can be altered by selecting 
an alternative value in the Window size selector.  The starting time position of the timeline window is controlled 
by sliding the timeline bar.  By default, the timeline display is positioned to cover a range up until the last event. 
At any time the display can be refreshed by clicking the Reload button. 
  

Channels Event 

Range of time limits 

Guard defined limits 

Time slider 

Sever Selection 
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Events are displayed as color coded horizontal bars with the following colors representing the different types of 
events: 

Flame events red 

Smoke events blue 

Offsite events (RFL) purple 

Motion events green 

User events orange 

Fault events yellow 

Disconnect events grey 

In addition, Tool-tips will provide extensive information on each event when the mouse pointer is hovering over 
the event bar [Figure 49]. 

 

Figure 49: Timeline Window Tool-tips 

To playback or download an event, right click on the event and select the appropriate option:  Play Event Movie..; 
Download Event Movie. 

 

Figure 50: Playing or Downloading Single Alarm Events 
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3.3.5.1 Playing Back Arbitrary Time Ranges 

Timeline view [Figure 51] allows you to set arbitrary time limits and play back the video recorded from any 
channel. To set up the time limits drag the inverted rectangles (orange) located at the top edge of the timeline 
diagram as desired, select the channel View in the Selected Time group. You can then right click the channel 
within the selected time limits and choose “Play Timeline..” or “Download Timeline..”. 

 

Figure 51: Timeline Chart of activities with guard defined time range set 

3.4 Status Bar 
Across the bottom of the program window, this bar displays information about the current system configuration 
[Figure 52].  

 

 

 

 

 

 

 

Figure 52: Main Window Status Bar 
  

Timeline Limit Indicator 

No. of cameras 

No. of servers 

Current date & time 

Normally blank unless
changes have been

made; then “Modified”
will be displayed until

file is saved.

LED Annunciator 
Connected

E-mail on/off indicator 
Red “X” displayed if “Off” 

Relay status indicators. 
Visible only if relay 
module is connected. 

Relay connected indicator 
“Relays” = connected 
“No Relays” = not connected 
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4.0 Testing, Maintenance and Service 
Testing, Maintenance and Service of the Fike Video Analytics system shall only be conducted by Fike factory 
trained service technicians in accordance with published instructions. Any attempt to test, maintain or service 
the system using untrained personnel may achieve undesired and invalid results, which can lead to improper 
operation of the system. 
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